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Welcome to Pocket Quads™ 
 
Thank you for purchasing Prosurv Pocket Quads!  To get all the benefits of Pocket Quads on your 

Pocket PC, Prosurv recommends the following hardware and software: 
 
• A GPS receiver such as the DeLorme Earthmate GPS with Bluetooth® PowerPack 

(requires a Bluetooth®-enabled Pocket PC).  Or, any GPS receiver that outputs NMEA 
data through a COM port (a ‘virtual’ com port, such as when using COM 8 with a Blue-
tooth® device, or via a cable connection using COM 1), on your Pocket PC.  Note that 
some Pocket PC devices, such as the HP iPAQ 1900 Series DO NOT HAVE SERIAL PORT 
CAPABILITIES. 

• USGS 7.5’ Topo Quad sheets (DRG’s), for your State, or your destination State (such as Yel-
lowstone National Park, in Wyoming and parts of Idaho and Montana).  State by 
State USGS 7.5’ Quad maps can be purchased at our web site at www.prosurv.com.  
Prosurv LLC sells the exceptional All Topo Maps Series of USGS maps by iGage Cor-
poration.  The All Topo Maps Software has the ability to export each map as a Geo-
referenced .tif file, which can be used by Prosurv Imaging to create the images used 
by Prosurv Pocket Quads. 

• A Pocket PC with a 400Mhz Intel X-Scale processor, and Windows Mobile 2003 Op-
erating System.  The HP iPAQ 2215 is the model currently recommended by Prosurv. 

• A large-capacity storage card (flash card) such as an SD Card or CF Card with 
256MB or 512MB RAM.  A 512MB flash card can store about 170 Prosurv-
compressed Quads.  As a reference, the entire Yellowstone NP requires about 70 
Quad Sheets. 

 
 
 

To prepare a Quad Sheet for use with Pocket Quads requires the following: 
 
• Any Georeferenced .tif image representing a USGS 7.5’ Quadrangle.  Georeferenced means 

that along with the .tif image, there is also a .tfw (world) file in the same folder as the .tif image 
file.  This world file contains information about the image, such as the coordinates for the upper 
left corner of the image.  Some web sites allow you to download USGS Quad images (DRG’s).  
Typically when downloaded, the image will come with a georeference file. 

• Prosurv Imaging—used to divide each Quad Sheet image into a number of ‘slices’.  Pocket PC’s 
do not have the resources (ie memory) to open an entire Quad image.  Therefore, Prosurv pre-
pares the image(s) for use by Pocket Quads by creating a new folder that contains dozens of 
slices of the original image. 
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Installing Pocket Quads 
Thank you for purchasing Prosurv Pocket Quads!  Your purchase comes with 15 days of free tech 

support…so please feel free to call toll-free 888-647-9500 or e-mail us at techsupport@prosurv.com if 
you have any questions about installing or using Prosurv Pocket Quads! 

 
If you purchased on-line and have downloaded Pocket Quads from our web site 

The download is a compressed or “zip” file which contains all of the installation files necessary to in-
stall Pocket Quads onto your Pocket PC.  You should use any popular unzip tool to extract and save 
the files to a new folder on your PC.  Now, follow the instructions as if you’ve copied the files from a CD 
to your PC. 

 
What’s on the CD 

The Prosurv Pocket Quads CD contains several files used for installation of Prosurv Pocket Quads to 
your Pocket PC.  The CD also includes one or more Adobe Acrobat pdf files.  You may need to download 
the free Adobe Acrobat reader, which can be found at www.adobe.com.  The following files can be 
found on your CD: 
• This installation and user’s guide 

 
Copy your Prosurv Pocket Quads CD to your PC.  Do Not Install from the CD 

The files contained on the Prosurv Pocket Quads CD may be marked “Read-Only”.  Therefore, it is 
recommended that you first copy all the files and folders from the CD to a new folder on your 
PC.  You can select all the files and folders (Ctrl-A), and then paste them into your new folder on the PC 
(Ctrl-V to paste).  Once copied, select all the files and folders in the new folder (that you just copied 
to) and Right-Click the group.  Select Properties and uncheck the Read-Only property if it’s al-
ready checked.  Now, you can proceed with the normal installation, using the Prosurv Pocket Quads files 
that are now on your PC. 

 
Begin the Installation 

Before installing Prosurv Pocket Quads, 
you need to have a connection already 
established between your PC and your 
Pocket PC device.  Use Microsoft Active-
Sync® to establish the connection.  If you 
have not yet done so, you need to install 
Microsoft ActiveSync® to your PC.  
ActiveSync® is included on the 
Prosurv Pocket Quads CD for your 
convenience.  To install Microsoft 
ActiveSync®, run the MSASYNC.EXE 
file from the Prosurv Pocket Quads CD.  
Then follow the on-screen instructions to 
complete the installation. 
 
You must be connected and 
synchronized with your Pocket PC and 
have setup a partnership between your 
Pocket PC and your PC using Microsoft 
ActiveSync.  A Guest partnership in 
ActiveSync may not allow you to install 
Pocket Quads to your Pocket PC. 

 
Once your connection is established, you will see the screen shown above. 
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Installation of Prosurv Pocket Quads is done in four steps: 
 
Step 1: Double-click the Run This First.exe file 
Double-click the Run This First.exe file.  This will install certain supporting 
files to your PC to ensure that Prosurv Pocket Quads will install on your de-
vice.  Follow the on-screen instructions to complete this installation. 
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Step 1 has now been completed. 
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Step 2: Install Prosurv Pocket Quads to your Pocket PC 
Double-click the Installer_2003.exe file to begin installing Prosurv Pocket 
Quads to your Pocket PC. 
 
 
 

Note: ActiveSync must be installed, and a connection to your Pocket PC must already have been es-
tablished in order to complete this step. 

 
• Your Activesync connection should display Synchronized before you double-click the Installer.exe 

file. 
 
 
 
 
 
 
 
 

 
You should see the Prosurv LLC Prosurv Pocket 
Quads caption next to the check box.  Make 
sure the box is checked.  There is also another 
file which you must install in order for Prosurv 
Pocket Quads to run, called Microsoft VB 
Runtimes for PPC.  Be sure that you check 
both files so that they both install. 
 
Also be sure that the “Install program into the 
default installation folder” caption is checked as 
well. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Now press OK to begin the installation! 
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Tap OK.  The necessary installation files have now been copied to your Pocket PC.  Now we need to 

complete the installation on your Pocket PC… 
 

Step 3: Completing the installation on your Pocket PC 
 
Be sure to tap No to All on the Pocket PC. 
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Installation of Prosurv Pocket Quads to your Pocket PC has now 
begun. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Once installation has completed, your Pocket PC’s screen will 
return to the familiar Today screen. 
 
To run Prosurv Pocket Quads, tap the Start Menu and select 
Programs. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
You should now see the Prosurv Pocket Quads Icon near the 

bottom of the screen. 
 
Tap the Prosurv Pocket Quads Icon to start Prosurv Pocket 

Quads. 
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Step 4: Write Down The Pocket PC’s Device Serial Number given by Prosurv Pocket Quads 
Pocket PC 2003 devices, including iPAQ, Dell, and others, either don’t contain a unique device serial 

number, or, the serial numbers are not accessible by software such as Prosurv Pocket Quads.  However, 
you must have a unique serial number for your device in order for Prosurv LLC to provide you with a 
valid Registration Key. 

 
IMPORTANT NOTE: Now that you’ve installed and ran 
Prosurv Pocket Quads, a message will pop up that dis-
plays your unique Prosurv Pocket Quads Device Serial 
Number.  You must write this number down and con-
tact Prosurv LLC to obtain your Registration Key. 
 
You must contact Prosurv LLC to obtain your Prosurv Pocket 
Quads Registration Key.  You may call toll-free 888-647-9500 
or e-mail us at techsupport@prosurv.com.  You may call or e-
mail 24 hours a day, 7 days a week to obtain your Prosurv 
Pocket Quads Registration Key. 
 
You can also obtain your Prosurv Registration Key by 
visiting our web site and entering your username, pass-
word, and device serial number. 
 
 
 
 
 
 
Once you’ve obtained a Registration Key, carefully enter the 
key and tap the Register button. 
 
Note: If you close Pocket Quads before entering your key, or 
before obtaining your key, simply re-run Pocket Quads again to 
see your “Device Serial Number” as given to you by Prosurv 
Pocket Quads.  This 
unique, random num-
ber will be compared 
with your Registration 
Key to ensure valid 
user authorization. 
 
If all goes well, you 
will see “Authorization 
valid”, and Prosurv 
Pocket Quads will fin-
ish Loading… 
 
 

 
It can take anywhere from 10 to 30 seconds for Prosurv 

Pocket Quads to “Boot up”, depending on your Pocket PC and 
it’s available memory. 
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Prosurv Pocket Quads has now been completely installed! 
 
You are now ready to begin using Prosurv Pocket Quads. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Important information you should know 
Pocket Quads installs to the \Program Files\Pocket Quads\ folder on your Pocket PC.  Inside this 

folder is a file called Defaults.txt.  This file contains information that can be changed by you.  You can 
copy the file to your PC using Microsoft ActiveSync.  Make a backup of the file, then make the changes 
that you’d like to make.  Finally, copy the file back to the folder that it came from, overwriting the exist-
ing file (when asked). 

 
The Defaults.txt file contains the following information: 
 
QuadPath=\Program Files\Pocket Quads\ 
Units=meters 
JobZone=UTM,12 
RefreshRate=1 
GPSIndicatorRate=10 
ComPort=8 
BaudRate=19200 
FilePath=\My Documents\ 
DefaultQuad=O44110D7.pcq 
 
The QuadPath is the only path that Pocket Quads will use when searching for any particular Quad 

sheet automatically (for example, when connected to a GPS receiver, Prosurv Pocket Quads will deter-
mine the name of the Quad sheet needed for proper display of the current GPS location).  Initially, this 
path is defined to be the Pocket Quads folder of your Pocket PC.  However, it is recommended that this 
path be changed to a path representing the location of your own, personal, Quad sheets.  You should 
use ActiveSync to explore the path names to your flash cards, so that you use the proper path name.  
For example, on an HP iPAQ 2215, the path to your CF Card (compact flash) is simply \CF Card\.  The 
path to your SD Card is simply \SD Card\.  Let’s say you’re going to take a trip down Interstate 80, and 
you’ve created several Quads for the trip.  You could store them on a CF Card in a folder called I80.  
Then, your QuadPath would be; 

QuadPath=\CF Card\I80\ 
 
Be sure to include the final backslash, or you might get a file not found error, or invalid path. 
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Units= 
Valid entries for Units= are: 
• Units=meters 
• Units=usfoot 
• Units=ifoot 

 
JobZone= 

The Job Zone defines the coordinate projection system that is used, by default, when creating or re-
cording points.  All NAD83 State Plane Coordinate Zones and UTM1-60 Zones are valid.  If you are not 
familiar with projections and zones, then you should use the UTM Zone that is the same as your image 
zone.  For example, in your area, all of your Quad Sheets may use the UTM 12 projection.  Therefore, if 
unfamiliar with zones and projections, then you should define your JobZone as the same projection, in 
this case, UTM 12. 

 
For those familiar with projections and zones, you can select to use a different projection than the 

one used by the image.  For example, even though your image’s projection is UTM 12, you could use 
the Wyoming West Central state plane coordinate projection for each file, or job, that you create.  This 
allows you to collect your point data in Wyoming West Central coordinates, rather than having to collect 
the data in UTM 12 coordinates. 

 
To define a JobZone, enter the name of the projection, then a comma (,) followed by the zone, such 

as: 
• JobZone=UTM,12 
• JobZone=Wyoming,West Central 
• JobZone=Tennessee,All 
• JobZone=Montana,All 

 
RefreshRate= 

The Refresh Rate indicates how quickly Prosurv Pocket Quads will attempt to refresh the GPS signal 
over the image.  Default is every 1 second.  Slower Pocket PC’s should use a refresh rate of 1.5 to 2 
seconds or more.  Faster Pocket PC’s could use a refresh rate faster than every 1 second, such as 0.5. 

 
Valid entries are: 
• RefreshRate=1.5 
• RefreshRate=1 

 
GPSIndicatorRate= 

This value should not be changed by the user.  The default value is 10 (milliseconds). 
 

ComPort= 
The Com Port indicates which com port is used (by default) when trying to achieve a connection with 

a GPS receiver.  Typical values are 1 for a normal, wired connection, and 8 for a wireless connection. 
Valid entries are: 
• ComPort=1 
• ComPort=2 
• ComPort=3 
• ComPort=4 
• ComPort=5 
• ComPort=6 
• ComPort=7 
• ComPort=8 
• ComPort=auto 
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BaudRate= 
The Baud Rate indicates the default baud rate used by Pocket Quads when trying to achieve a con-

nection with a GPS receiver.  Default value is 19200. 
 
Valid entries are: 
• BaudRate=4800 
• BaudRate=9600 
• BaudRate=14400 
• BaudRate=19200 
• BaudRate=38400 
• BaudRate=57600 
• BaudRate=auto 

 
FilePath= 

This is the default path used when you create a new “points” file.  Default path is: 
• FilePath=\My Documents\ 

 
You can store your point files to a CF Card or SD Card by default by entering the path needed.  Note 

that storage to a card may cause the program to slow down. 
 

DefaultQuad= 
If you change your QuadPath, you must also change your DefaultQuad.  This indicates the 

name of the default Quad sheet that is loaded each time you start Pocket Quads.  The path and name 
of your default Quad sheet must exist. 

 
When you first install Pocket Quads, a Quad sheet is installed with the program in the \Program Files

\Pocket Quads\ folder of your Pocket PC.  The initial default quad is: 
• DefaultQuad=O44110D7.pcq 

 
The .pcq file is a special file created by Prosurv Imaging that contains information about the slices for 

displaying the Quad Sheet.  A new folder, called “O44110D7” is also found in the \Program Files\Pocket 
Quads\ folder of your Pocket PC.  This folder contains all the slices for that Quad sheet (in a com-
pressed .png format). 

 
Using the example above, let’s say you’ve created a dozen Quad sheets for an upcoming trip across 

Interstate 80.  Using Prosurv Imaging, you’ve saved 12 new Quads and their folders to a Compact Flash 
Card, to be used on your Pocket PC (refer to the Prosurv Imaging documentation for more information 
about creating the Pocket Quads files). 
 

Using ActiveSync’s 
Explore button, when 
looking at the contents 
of the CF Card, you’d 
see what is shown on 
the right. 
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Double-clicking on the I80 folder reveals several 
pcq files and their corresponding folders, which 
were created by Prosurv Imaging. 
 
So, you would want to set your DefaultQuad= to 
one of the pcq files in the list.  For example: 
• DefaultQuad=O41104G7.pcq 
 
Then, when Prosurv Pocket Quads is ran, it will 
look for the Quad located at: 
\CF Card\I80\O41104G7.pcq 
 
This file should exist, otherwise an error will be 
displayed. 
 
 
 
 
 
 
 
 
 
 
 
 
 

IMPORTANT NOTES: 
• YOU CAN CHANGE THE VALUES IN YOUR DEFAULTS.TXT FILE USING THE FILE EX-

PLORER PROGRAM ON YOUR POCKET PC.  SIMPLY FIND THE DEFAULTS.TXT FILE US-
ING THE FILE EXPLORER PROGRAM, THEN SINGLE-TAP THE FILE TO EDIT.  TAP OK 
WHEN EDITING IS COMPLETE TO SAVE THE FILE.  BE SURE TO THEN EXIT AND RE-
START PROSURV POCKET QUADS SO THAT IT USES THE NEW DEFAULTS. 

• CHANGES TO THE DEFAULTS.TXT FILE WILL NOT BE USED UNTIL YOU’VE EXITED, THEN 
RE-STARTED PROSURV POCKET QUADS. 

• BE SURE THAT, IF MAKING CHANGES TO THE DEFAULTS.TXT FILE ON YOUR PC, YOU 
REMEMBER TO COPY AND OVERWRITE THE EXISTING FILE WITH THE CHANGED DE-
FAULTS.TXT FILE ON YOUR POCKET PC. 
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Using Prosurv Pocket Quads 
 
There are 3 Menus in Prosurv Pocket Quads: 
1. File 
2. Edit 
3. GPS 

 
There are 5 buttons in Prosurv Pocket Quads: 
1. Pan On/Off 
2. Slices On/Off 
3. Center On/Off 
4. Text / Lines 
5. Navigate On/Off 

 
Tapping the screen and “dragging” (gently dragging your 

stylus across the screen) will give different results, depending 
on the selections in the menu as well as which buttons are cur-
rently on or off. 

 
When you first run Pocket Quads, the program will read the 

defaults file and determine the name and path of the default 
Quad sheet to be loaded.  Loading of the Quad will take place 
automatically.  It is important that the default Quad sheet exists in the folder, for proper running of the 
program. 

 
Many functions only work after you’ve created a file.  A file will store any points that you create, or 

points that are recorded by the GPS Recorder.  The file also stores other information, such as lines that 
are drawn. 
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The File Menu 
 
The File Menu contains the following functions: 
• Load Quad Sheet 
• New File 
• Open File 
• Import Points 
• Export Points 
• About Pocket Quads 
• Exit 
 
 
 
 
 
 
 
 
 
 
 
 

Load Quad Sheet 
The Load Quad Sheet function lets you load any Prosurv Compressed Quad (.pcq) image.  The .pcq 

file can be in any folder, however, the folder containing the actual images (it has the same 
name as the .pcq file) must also be in that same folder. 

 
Center on GPS button 
 

Quad sheets will load (change) automatically when using a GPS 
receiver and the Center on GPS button is ON.  However, if GPS 
is off, or the Center on GPS button is off, then you can load in-
dividual Quads as needed. 
 
Tap the Load Quad Sheet function.  All .pcq files available will 
be shown.  Tap Cancel to exit, or tap the pcq file to load 
that quad. 
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The O36086A6.pcq Quad sheet has been loaded. 
 
Once a sheet is loaded, Prosurv displays a grid that shows the 
current slice being viewed.  The example shows that the Quad 
has been sliced into 7 columns and 9 rows, for a total of 63 
slices.  Typically, each slice is 2000 meters x 2000 meters. 
 
When GPS centering is on, Prosurv Pocket Quads determines 
the proper Quad sheet to load, and, the proper slice to display, 
based on your current GPS position. 
 
The grid also displays the name of the currenlty loaded Quad 
sheet (and slice, which in this case is slice #1).  When a file is 
created or opened, the name of the file will also be displayed 
on the grid. 
 
Once a Quad has been loaded, you can use the stylus to “pan” 
through the current slice.  To do this, be sure that the  
 
pan button is On (indicated by a black rectangle around the 

button).  Then, tap and hold the stylus on the screen and drag the stylus in the direction that you’d like 
the image to move.  Release the stylus to stop the pan action. 

 
Note: Use of a screen protector is recommended to 
avoid damaging the touch screen while panning. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Tap the Grid Button to make the grid disappear, as 
shown to the right. 

 
Tap it again to make the grid reappear. 
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New File 
Files are used to store data.  The files created by Pocket Quads are Pocket Access Database files.  

When you create a new file, it will have a .ppq extension.  In other words, if you create a file called Va-
cation, the file name will be Vacation.ppq.  This extension tells your Pocket PC that the file is a Pro-
surv Pocket Quads file. 

 
An In-Depth Look at the Data Stored by Pocket Quads 

For those familiar with using Microsoft Access on their PC, by renaming the Pocket Quads file and us-
ing Microsoft ActiveSync to transfer the file, Microsoft can convert the database to a Microsoft Access 
database which can be viewed on your PC.  So, in other words, the files you create in Pocket Quads are 
fully compatible with Microsoft Access.  To do this, you would: 
• Be sure that the file is closed (not in use) on your Pocket PC 
• Connect your Pocket PC to your PC using ActiveSync 
• Be sure that the Tools—>Options—>Rules—>Conversion Settings—>Convert Files when copied… 

is checked in Microsoft ActiveSync 
• Rename the file using ActiveSync so that the extension is changed from .ppq to .cdb 
• Copy the file to your PC using ActiveSync, converting it to a .mdb file along the way (done by Ac-

tiveSync) 
 

Now, you can easily view and use all the data collected by Pocket Quads! 
 
Currently, Prosurv Pocket Quads stores the following information in your file: 
 

The Points Table 
• Point # ...............An auto-numbering sequential number, starting with 0 
• North ..................Northing coordinate of the point, based on the Job Zone 
• East ....................Easting coordinate of the point, based on the Job Zone 
• Elev ....................Elevation of the point 
• Zone ...................Name of the zone currently selected as your Job Zone 
• MyText ...............The text you entered as the “Annotation” for the point, for example, Camp 
• Quad ..................The current Quad being used when the point is stored 
• Slice ...................The current Slice being used when the point is stored 
• X ........................X coordinate of the point on the image 
• Y ........................Y coordinate of the point on the image 
• OffsetX ...............The X value of the left edge of the slice being viewed (pan amount) 
• OffsetY ...............The Y value of the top edge of the slice being viewed (pan amount) 
• Font ...................The current Font 
• Points .................The current text size, in points 
• Weight ................The current line weight (width), in pixels 
• Italic ...................For printing the text on the screen, True or False 
• Underline ............For printing the text on the screen, True or False 
• Strikeout .............For printing the text on the screen, True or False 
• Layer ..................The Layer assigned to the point 
• ColorR ................The Red value for the color of the point 
• ColorG ................The Green value for the color of the point 
• ColorB ................The Blue value for the color of the point 
• Visible .................Whether the point is visible, True or False 
• FCode .................The Feature Code for the point 
• Att ......................Attributes associated with the point 
• ClickN .................The Northing value, in the current Job Zone’s coordinate system of the tapped 

 ..........................location on the screen.  When a screen-tapped point is stored, if GPS is ON, the 
 ..........................North and East values will store the GPS North and GPS East coordinates, which 
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 ..........................could be very different than the tapped value.  For example, you may be walk
 ..........................ing on a path towards a bridge that is 200 feet away.  When you tap the bridge 
 ..........................to create a point, the screen location of the bridge is stored as the ClickN 
 ..........................and ClickE values, and the current GPS location (North & East) is stored as 
 ..........................the North and East values. 

• ClickE .................See the notes for ClickN above 
• Units ..................The current Units for the Job (File), either Meters, US Foot, or International 

 ..........................Foot 
• GPSLat ...............The GPS Latitude, as reported in the NMEA data string by your GPS receiver 

 ..........................when the point is stored. 
• GPSLong .............The GPS Longitude, as reported in the NMEA data string by your GPS receiver 

 ..........................when the point is stored. 
• Deleted ...............True or False, whether the point has been deleted 

 
The Lines Table 

• Line ....................An auto-numbering sequential number, starting with 0 
• FromN ................The Northing coordinate of the starting point of the line 
• FromE ................The Easting coordinate of the starting point of the line 
• FromZ ................The starting elevation 
• Zone ...................Name of the zone currently selected as your Job Zone 
• Quad ..................The current Quad being used when the line is stored 
• Slice ...................The current Slice being used when the line is stored 
• FromX ................The X (image) value of the starting point of the line 
• FromY ................The Y (image) value of the starting point of the line 
• FromOffsetX ........The current X offset (pan amount) of the slice 
• FromOffsetY ........The current Y offset (pan amount) of the slice 
• ToN ....................The Northing coordinate of the end point of the line 
• ToE ....................The Easting coordinate of the end point of the line 
• ToZ ....................The elevation of the end point of the line 
• ToX ....................The X (image) value of the end point of the line 
• ToY ....................The Y (image) value of the end point of the line 
• ToOffsetX ...........The current X offset (pan amount) of the slice 
• ToOffsetY ...........The current Y offset (pan amount) of the slice 
• Width .................The line width 
• Layer ..................The Layer assigned to the line 
• ColorR ................The Red value for the color of the point 
• ColorG ................The Green value for the color of the point 
• ColorB ................The Blue value for the color of the point 
• Visible .................Whether the line is visible, True or False 
• Deleted ...............True or False, whether the line has been deleted 
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Creating a New File 
Tap New File to create a new database file.  Enter a File 

Name such as My Vacation and tap the Create button. 
 
A new file is created and stored on your Pocket PC.  The 

Path is used to define where the new file is stored.  Note that 
you can change this path, by default, by editing the Defaults.
txt file, which is found in the \Program Files\Pocket Quads\ 
folder of your Pocket PC. 

 
You can store files directly to either a CF (Compact Flash) 

card or SD (Secure Digital) card by using the path name to the 
card.  For example, on a Windows Mobile 2003 device such as 
the HP iPAQ 2215, the path to the CF Card is simply \CF Card\.  
The path to an SD Card is simply \SD Card\.  You can use Ac-
tiveSync to explore (and determine) the correct path names to 
use.  Storing directly to a flash card may be slightly slower than 
storing to internal memory, however, flash cards are consid-
ered as non-volatile memory, and as such, it is less likely that 
you could accidentally lose data when storing to a flash card 
(for example, if all power was lost in a Pocket PC, chances are that all data stored on the Pocket PC 
would also be lost, however, data stored on a flash card would still be safe). 

 
Once the File is created, the name of the File is shown with the 
Quad name above it. 
 
You must create (or open) a file to do the following functions: 
• Import Points 
• Export Points 
• Tap and Create Annotations (points) 
• Hand-enter a Point (coordinate or Lat/Long) 
• Create or Draw Lines 
• View/Change Layers 
• View Data 
• Tap to View a Point 
• Tap to View Distances With Point Searching ON 
• Record GPS Points 
• Navigate to Points 
 
Once you create a File, you can perform all of the functions 
listed above. 
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Open a File 
To open a file that you’ve created previously, select Open 

File from the Menu. 
 
All .ppq (Prosurv Pocket Quad) files that exist in your Pocket 

PC will be shown (even those on CF or SD Cards).  Simply tap 
the file that you’d like to open, or tap the Cancel button to exit. 

 
The Pocket Quads icon 
is shown next to each 
Pocket Quads file, for 
easy identification of 
the file. 
 
 
 
 
 
 
 
You can also open a Pocket Quads file, and launch the Pocket 
Quads application by using File Explorer on your Pocket PC, 
and then tapping the file that you’d like to open. 
 
 
 
 
 

 
Import Points 

The Import Points routine will read a text file that contains points in the following format: 
Point (Name or Number),Northing,Easting,Elevation,Feature Code 
 
Each field must be separated by a comma.  The Point # will 

be stored in the MyText field of the database, and each point 
will be stored as a waypoint.  Imported points can then be 
used to Navigate to.  You can use the Prosurv Imaging pro-
gram to Export Points in this format.  Many other programs and 
CAD software allow you to export points that can be imported 
into software, such as Pocket Quads.   

 
Pocket Quads looks for a .asc extension when first searching 

for available text files to import.  The “Type” drop-down allows 
you to view files with either the .asc or .txt extension, or any 
extension. 

 
To begin importing the points, simply tap the file that you’d 

like to import. 
 
 
 
 
 



Prosurv Pocket Quads™ Installation and User’s Guide 

Page 21 

An example .asc file might contain: 
CAMP,495652.12,565075.44,1318.51,OUR CAMP SITE 
BRIDGE,495712.14,565044.43,1322.15,BRIDGE OVER TROUBLED WATER 
LAKE,495999.7,565135.47,1312.0,EAST EDGE OF LAKE 

 
Tap the File to begin importing the points.  If you goes well, 
you will see an Import Report: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
You can view the data (that was imported) by going to 

Edit—>View Data. 
 
Note that the Quad Sheet needed for the coordinate is auto-

matically computed and stored with the point.  And a coordi-
nate transformation is performed that changes the imported 
coordinates into the Image Zone coordinates.  These changed 
coordinates are stored as the “Click North” and “Click East” 
data.  The original Northing and Easting (that were imported) 
are kept the same and are stored as the Northing and Easting 
of the point. 
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Export Points 
The Export Points routine writes all of your points (in the 

current File) to a text-readable file. 
 
Select Export Points from the Menu, then enter a name to 

Save As. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Tap the OK button to accept the file name.  You will now see 
the Export File dialog: 
 
 
 
 
 

Choices include the number of decimal places for Northings, 
Eastings, and Elevations (Default=4). 

 
You can also enter a scale factor which will be used to multi-

ply each Northing and Easting upon Export.  This is for ad-
vanced users who wish to change the data from State Plane 
Coordinates to Surface Coordinates (using a Datum Adjustment 
Factor also known as a Combined Scale Factor). 

 
You can select to use a comma, tab, or space character to 

delimit the fields being exported. 
 
Finally, you can select the type of output (format) for Lati-

tudes and Longitudes.  Tap the Export button to write to the 
file. 

 
Note:  Exported data files have the .asc extension, however, they can not be directly im-

ported into a different Pocket Quads file using the Import Points routine at this time. 
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You can copy the exported file to your PC using Microsoft ActiveSync, then you can view the text file 
using Notepad. 

 
Tip:  Using a comma as the delimiter allows you to easily open the file using Microsoft Excel.  Simply 

rename the file to .csv (instead of .asc).  Then, double-click to open it in Excel. 
 

About Pocket Quads 
Tap the About Pocket Quads selection to view important se-
rial number, registration key, and copyright information about 
Prosurv Pocket Quads. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Exit 
Tap the Exit selection to exit Prosurv Pocket Quads, closing 
any File automatically, if one is currently open. 
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The Edit Menu 
Enter Point 

Pocket Quads lets you easily hand-enter a point.  You can enter 
either Northing and Easting coordinates, or the Latitude and 
Longitude of the point. 
 
 
When you tap the En-
ter Point selection, 
you’ll see: 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
You can enter a Name for the point (the next autonumber is 
used by default), or you can select a pre-defined name from 
the drop-down list: 
 
Tip:  The drop-down list of Names is user-definable.  
Simply edit the Codes.txt file located in the \Program 
Files\Pocket Quads\ folder of your Pocket PC.  Once ed-
ited, you’ll need to Quit (Exit) Pocket Quads, then re-
start Pocket Quads which will load the new file. 
 
If entering a Northing and 
Easting coordinate, be sure 
to select the Coordinate 
option.  If entering a Lati-
tude and Longitude, be sure 
to select the Lat/Long op-
tion.  Tap the ? button to 
see the notice shown here. 

 
You can also select which layer the point is assigned to.  Individual layers can be turned on and off.  

For example, Layer 0 might contain your camp site points, while Layer 1 contains points that were 
stored while walking down a certain path. 

 
Tap the Store button to store the new point to the file. 
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Settings 
The Settings selection has several options: 
• Default Quad Sheet Path—You can edit the default 

path used for searching for Quad sheets here.  However, 
it is recommended that you edit the default path in the 
Defaults.txt file instead. 

• Img Zone—This is the image zone currently being used 
by Pocket Quads, based on information contained in 
the .pcq file for this Quad.  This value should not be 
changed, unless it is known that the Quad sheets zone 
(Img Zone) is currently incorrect. 

• Job Zone—Indicates the Zone that you’d like to use for 
your Job File.  If this is different than the Image Zone, 
Pocket Quads will automatically transform coordinates 
between the Image and Job Zones when needed.  All of 
your stored points, GPS Recorded points and other data 
will have coordinates based on this selected Job Zone. 

• ULC North—Indicates the northing coordinate, in the 
Image Zone of the Upper Left Corner of the Quad Sheet 
being used.  Coordinates for the ULC are assumed to be 
metric, and must be NAD83 datum coordinates. 

• ULC East—Indicates the easting coordinate, in the Image Zone of the Upper Left Corner of the 
Quad Sheet being used.  Coordinates for the ULC are assumed to be metric, and must be NAD83 
datum coordinates. 

• Refresh Rate Button—Allows you to change the value, in seconds, of the GPS Refresh Rate.  
Slower processors should use slower refresh rates, such as 2 seconds or longer.  Faster proces-
sors can use refresh rates of 0.5 to 1 second. 

• Tap Radius—The tap radius is the search radius used by Pocket Quads when searching for 
points based on a screen tap.  A radius of 10 means all points within 10 meters (or feet if using 
US Foot Units). 

• Units—Select the units that you’d like to use for the current job (file).  You can change your 
units, by default, by editing the Defaults.txt file located in the \Program Files\Pocket Quads\ 
folder of your Pocket PC. 

• Sound—Turn all sound On or Off (applies to Pocket Quads only). 
• # of Records—Indicates the total number of records in the current file. 
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Line Settings 
Tap the Line Settings selection to view the following 

screen: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The Line Settings routine lets you: 
• Enter a line width 
• Select a line color 
• Select a Layer that will contain any lines drawn after the selection 
• Connect GPS Points (Recorded Points) 

 
Tap the Color button to select a color to use for the line(s). 
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Layers 
Tap the Layers selection to turn Layers On/Off and change 

other Layers settings. 
 
Imagine that layers are just like drawing on a see-through 

surface—like a clear piece of plastic.  On one piece of the clear 
plastic, you might draw lines for a house.  On another piece, 
you draw lines for the sidewalks and driveway.  On yet another 
piece, you draw the sky and the lawn. 

 
Now, when you overlay the pieces, you have a complete pic-

ture.  By putting certain points and lines on specific layers, and 
turning layers on and off, you can alter the picture that you see 
on the image. 

 
Pocket Quads has 9 layers (numbered 0 to 8).  You can also indicate which layer Imported Points 

will be stored on. 
 
When creating lines and points, you’re given the option of which Layer to store the points and lines 

on. 
 
The Auto Regen Screen check box, when checked, will force Pocket Quads to redraw your lines 

and points when you tap the OK button.  Or, tap the Regen button to force an immediate re-drawing 
of your points and lines. 

 
Tip:  Pocket Quads searches the entire file for all the lines and points that fall within the 

current slice ONLY.  Lines and Points that are on a layer that has been turned OFF, will NOT 
be plotted at that time.  Each time a Regen is performed (either automatic or manual), 
Pocket Quads re-loads the current image slice, which effectively wipes the image clean, 
then re-plots the lines and points. 
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View Data 
Tap View Data to scroll through the records in your file, 

one record at a time: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Tap the Arrows to: 
• Go to the First Record 
• Go Back One Record 
• Go to the Next Record 
• Go to the Last Record 

 
Tap the ? button to search for a particular point (by Name). 
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Tap View 
The Tap View option is either on or off.  Tap the option 

once to turn Tap View on, or tap it again to turn it off. 
 
If Tap View is ON, then Pocket Quads allows you to tap a 

point that’s currently on the image and view the data associ-
ated with that point.   The Search Radius, which can be set in 
the Settings screen, is used to determine which point is clos-
est to where you tapped. 

 
When a tapped point is found in the file, the color of the 

point will change to Magenta, and the point’s data is displayed.  
See the screens below. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Note:  The Tap View option overrides any other tap-
ping capabilities.  Turn Tap View OFF to create points 
and lines by tapping. 
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Tap Distance 
This option is also an On or Off option.  When you tap the 

Tap Distance selection, a dialog will pop up showing you the 
direction and distance between points.  Tap the option again to 
turn Tap Distance Off. 

 
Note:  You can move the “Direction & Distance” dia-

log elsewhere on the screen by “dragging” the box to 
the desired location using your stylus. 

 
 
 
 
 
 
 
 
 
 
 
This routine lets you find the distance between any two loca-
tions on the screen.  You don’t need any points to see what the 
distance is between two locations. 
 
Simply tap any two screen locations to see the distance be-
tween them, such as from a road intersection to a bridge.  The 
direction between the locations is given as an Azimuth and as a 
Bearing. 
 
 

By checking the Hold First Point check box, you can find multiple distances from one point.  For ex-
ample, how far is it from your camp site to the lake, and from your camp site to the road? 

 
The Search File check box tells Pocket Quads to search the 

file for existing points that are within a given radius of your 
screen tap location.  If no points in the file match your tapped 
location (within the radius as defined in Settings), then the 
screen tap location will be used. 

 
When a tapped point is found in the file, the color of the 

point will change to Magenta. 
 

Notes: 
The Tap Distance option overrides any other tapping 

capabilities.  Turn Tap Distance OFF to create points 
and lines by tapping. 

 
Turning OFF the Tap Distance selection will cause the 

Direction & Distance dialog to go away. 
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The GPS Menu 
 
The GPS Menu contains 4 functions: 
• Start/Stop GPS 
• GPS Data 
• GPS Satellites 
• GPS Recorder 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Starting Your GPS Receiver 
Notes: You must set your GPS Receiver to output NMEA data, if NMEA data output is not 

sent by default.  If using a Bluetooth connection to your GPS receiver, be sure that Blue-
tooth is turned on in your Pocket PC (as well as on your GPS receiver), and that you’ve al-
ready established a Bluetooth connection between the GPS receiver and your Pocket PC. 

 
Typically, Bluetooth connections require the use of Com Port 8 in your Pocket PC, while cable connec-

tions are Com Port 1. 
 
Once you’ve established a connection to your GPS receiver, simply tap the Start GPS selection to be-

gin receiving GPS data.  Once a connection has been established and GPS data is being received, the 
selection will change to Stop GPS.  So, stopping the GPS data is simply a matter of tapping the same 
selection. 

 
“Beeps” 

If Sound is on, you will hear an audible double-beep indicating that a connection has been estab-
lished with your GPS receiver.  Double and triple beeps are an indication of loading a different Quad 
sheet or slice.  Constant, single beeps are an indication that good GPS data (“fixed”) is coming in at a 
constant interval.  If constant beeping was present for a while, but is no longer, it could be an indication 
that there aren’t enough satellites (due to buildings, trees, or other blockage) to get a “good fix” on the 
satellites, or, that there simply aren’t enough satellites currently visible in the sky. 

 
5 satellites are normally required to achieve a “good fix”.  You can observe the current satellite con-

figuration by tapping GPS Satellites. 
 
When recording GPS points by time or distance intervals, you will hear a special beep each time a 

point is stored. 
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GPS Data 
Once a connection with your GPS has been established, you 

can select GPS Data from the Menu. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The GPS Data screen gives you: 
• Northing & Easting coordinates in the Image Zone and Job Zone 
• GPS Latitude & Longitude 
• Ellipsoid Height 
• Speed in meters per second or miles per hour 
• Heading 
• # of visible satellites 

 
Comm Port 

Com Port settings should be made using the Defaults.txt file.  
However, you can change the Port and Baud Rate settings 
manually in the program. 
 
The Port and Baud Rate pull-down boxes have an AutoDetect 
mode which can be used to automatically detect the correct 
port and baud rate settings.  You can use this to find out what 
your “default” settings should be, and then set them in your 
Defaults.txt file. 
 
Note that you can also Start and Stop the GPS signals from 
within the GPS Data screen. 
 
Tap the OK button to leave. 
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GPS Satellites 
Tap the GPS Satellites selection to view the current satel-

lite configuration. 
 
Pocket Quads displays the number of satellites as well as a 

graphic display of their current position. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

GPS Recorder 
Prosurv Pocket Quads’ built in GPS Recorder lets you record 

points at time or distance intervals. 
• Select Time Interval to record a point every 1, 2, 5, or 

10 seconds etc... 
• Select Distance Interval to record a point every 10, 

15, or 20 meters (or feet) etc... 
 
You may enter text that will be stored in the MyText field of 

the database, such as GPS Point.  While recording points, an 
audible beep will be heard for each point stored.  You can 
Start and Stop the recording of points, when needed.  Tap 
the Back button to exit the screen without stopping the re-
corder. 

 
GPS-Recorded points can be plotted using the Line Set-

tings routine, and they can be exported by using the Export 
Points routine. 
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Buttons & Screen Functions 
 
The 5 screen buttons offer different capabilities, depending on which buttons are pressed (ON), and 

which ones are Off.  From left to right, the buttons are: 
• Pan On/Off—When Pan is OFF, you can create points and lines by tapping the screen 
• Grid On/Off—When the Grid is On, you’ll see a grid representing the slices of the current Quad.  

If the Grid is Off, you can use the up/down/left/right button (physical button on the Pocket PC) to 
scroll around the image. 

• GPS Centering On/Off 
• Text or Lines (the button that says “Camp”) 
• Navigate to a Point 

 
Pan On/Off 

With Pan ON, using your stylus, you can “scroll” around the screen, effectivelly moving the slice up 
and to the left or down and to the right etc.  Simply drag your stylus across the screen in the direction 
that you’d like the image to move.  Remember that there is a limit to the edge of the slice, and, that 
some slices contain a large white border. 

 
With Pan OFF, you can tap to create an annotation (or point) on the current image slice.  If the Text 

or Lines button is ON, then you will be creating points.  If the Text or Lines button is OFF, then you 
will be creating Lines. 

 
Grid On/Off 

 
If the Grid button is ON, you’ll see the grid shown to the left (this grid is re-positionable 
by carefully tapping the outer orange edge of the grid and dragging it around).  The grid 
displays the current Quad, slice, and File information. 
 
To go to a different slice on the grid, simply tap the slice that you’d like to go to.  
The slice is loaded and any points or lines that are on a currently visible Layer 
within that slice are plotted and displayed. 
 
 

If the Grid button is OFF, you can use the physical left/right/up/down button of your Pocket PC to 
scroll around the image (slice). 

 
GPS Centering On/Off 

If GPS Centering is ON,  then the image will automatically center on the current GPS signal, and 
Pocket Quads will automatically load the correct Quad as well as the slice needed to display the current 
location. 

 
With GPS Centering OFF, you can continue to receive GPS data, but Pocket Quads will not attempt to 

center the image on the GPS signal, nor will it automatically load any Quads or slices. 
 

Text or Lines Button 
The following must be true in order to create Text or Lines on the image: 
• A File must be opened or created 
• The Pan button must be OFF 
• The Tap View selection must not be checked (in the Edit Menu) 
• The Tap Distance selection must not be checked (in the Edit Menu) 
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Then, if this button is ON, a point will be created by tapping the screen.  If this button is OFF, then a 
line can be drawn between two tapped screen locations. 

 
Tapping the Screen with the “Camp” button ON 

 
 
 
 
 
 
 
 
 
 
 
 
 

The tapped screen location is recorded immediately, and the screen shown (above) is displayed.  This 
is the “Annotation” screen, which lets you define the point that you’ve just created.  In this screen you 
can: 
• Select from many font options 
• Set the font size 
• Set the Layer that the point will be stored on 
• Select a Color for the point 
• Enter any text as the Name for the point (stored in the MyText field of the data) 

 
The coordinates of the tapped location, in the Job Zone’s coordinate system, are displayed. 

 
You can select from a pre-defined list of “names” for the point 
by tapping the pull-down arrow.  This list can be changed and 
added to by simply editing the Codes.txt file located in the 
\Program Files\Pocket Quads\ folder of your Pocket PC! 
 
 
To load the edited 
code list, simply quit 
and then re-start Pro-
surv Pocket Quads. 
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Tapping the Screen with the “Camp” button OFF 
 
The first tapped point will be the start of a new line.  Subse-
quent taps will create successive end points of new lines. 
 
You can change the Line Color, Width, and Layer using the 
Line Settings function. 
 
Remember, each line is also stored in your File, and lines are 
redrawn (just like points) when you load a new slice or Quad, 
depending on your current Layer settings.  Of course, lines and 
points are only redrawn on the Quads and Slices that they 
“belong to”. 
 
 
 
 
 
 
 
 
 

Navigate to a Point (Staking Out) 
 
Tap the Navigate to a Point button to see the Navigate dia-
log. 
 
The Navigate display shows you the direction and distance to a 
Waypoint.  Any waypoint can be used, including imported 
points, tapped points, and GPS Recorded points. 
 
GPS must be ON in order to utilize this functionality.  Begin by 
entering a point name or number to navigate to.  Then tap the 
Go button. 
 
You can stop the navigation by tapping Stop. 
 
 
 
 
 
 
 
 

The data is constantly updated to show you the current di-
rection and distance to the point. 

 
 
 
 
 
 
 



Prosurv Pocket Quads™ Installation and User’s Guide 

Page 37 

• The Show NE check box will display the amount N/S 
and E/W that you need to go to get to the point.  If un-
checked, Pocket Quads will display the direction and dis-
tance to the point. 

 
 
 
 
 
 
 
 
• Selecting From Point (instead of To Point) will “reverse” 

the data.  That is, the direction and distance shown will 
be from the staked point TO your current GPS lo-
cation. 

 
 
 
 
 
 
 
 
 
• Selecting the Show Bg check box will display the direc-

tion as a Bearing, instead of an Azimuth. 
 
 

Tap the Search button to search for a point by Name.  Or, 
tap the Tap button to select a point from the screen (by tap-
ping it). 

 
The Navigate dialog can be moved by carefully dragging 

the dialog around on the screen, using your stylus.  You can 
make the dialog go away by tapping the Navigate button on 
the toolbar. 
 
 
 


